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Chapter 1: Getting Started
Welcome to the FIRSTVUE™ application from Fisher-Rosemount. FIRSTVUE™ provides
complete control valve, actuator, and monitor sizing, and enables complete process
equipment selection and specification sheet generation.

This User’s Guide describes the tasks you can perform with FIRSTVUE™ and gives an
overview of the program’s main functions and screens. Useful tips are also provided. You will
find additional information in the on-line Help contained in the program.

This chapter provides instructions for installing FIRSTVUE™ and using the manual. It
contains the following sections:

• How to Use this Manual

• System Requirements

• Installing FIRSTVUE™

• Removing FIRSTVUE™

• Opening FIRSTVUE™

• Closing FIRSTVUE™ and Saving Your Work

How to Use this Manual
This manual contains an overview of FIRSTVUE™ functions, tasks, and screens. Most
Windows users will find the information in this manual all they need to use the program.
Additional help is available in FIRSTVUE™’s extensive on-line Help system.

This manual assumes that you are familiar with your computer and performing basic Windows
tasks, such as using a mouse, selecting menu commands, and opening and saving files. If
you need help with any of these tasks, please consult your Windows documentation.

System Requirements
To run FIRSTVUE™, you should have a personal computer 486 DX or higher.

FIRSTVUE™ is fully compatible with Windows 95 and 97.  FIRSTVUE™ is able to run on
Windows 3.11, but will not support Import ISA File, Export ISA File, and Edit ISA Map File
commands found under the pull-down File menu.

Memory requirements are 8 Megabytes of RAM and 30 Megabytes of hard drive space.
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Installing FIRSTVUE™
Before you begin, we suggest making a backup copy of your FIRSTVUE™ disks, storing the
original disks in a safe place, and using your copies for installation.

To install FIRSTVUE™:

1. Start Windows and File Manager.

2. Insert the first setup disk in floppy drive A or B.

3. Choose Run from File Manager’s File Menu or Windows 95 Start button.

4. In the command line, type: A:SETUP (if you put the setup disk in drive A), or B:SETUP (if
you put the disk in drive B).

5. Follow the instructions on your screen to complete installation.

 The installer places FIRSTVUE™ in the FIRSTVUE™ directory on your C drive and
installs MS DLLs into your Windows System Directory, if necessary. You can view a
complete history of files placed during installation in the INSTALL.LOG file on your hard
drive.

Removing FIRSTVUE™
To remove FIRSTVUE™:

1. Select the FIRSTVUE™ program from your Windows 95 Start button.

2. Select Uninstall.

3. Follow the instructions on your screen to uninstall FIRSTVUE™.

4. Another method of removing FIRSTVUE™ is deleting the program folder from My
Computer in a Windows 95  or Windows 3.11 operating system environment.

Opening FIRSTVUE™
To open FIRSTVUE™:

1. Select the Start button on the Windows 95 or 97 workspace.

2. Select Programs.

3. Move the  mouse to highlight the FIRSTVUE™ program.

4. Select the FIRSTVUE™ program item by depressing the left mouse button.

5. FIRSTVUE™ will launch and automatically take you to the header tab to begin working in
the software.

Closing FIRSTVUE™ and Saving Your Work
To close FIRSTVUE™ and save your work:

1. Select Exit from the File Menu.

The following dialog box appears:

2.  Click the Yes button to save your work.
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Chapter 2: FIRSTVUE™ Overview
Welcome to the FIRSTVUE™ application from Fisher-Rosemount. FIRSTVUE™ software
provides customers complete control valve, actuator, and monitor sizing, as well as project
management capability by enabling complete process equipment selection and specification
sheet generation.

This chapter will outline the basic functionality of FIRSTVUE™ and provide an overview of the
data and capabilities of the software. This section provides a brief roadmap to the capabilities
of the software and useful field definitions to increase understanding of the software. It
contains the following sections:

• Header Tab

• Item List Tab

• Sizing Tab

• Pull Down Menus

• Program Overview Diagram
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Header Tab
The header tab is the first screen visible upon launching the software package. This screen
provides basic information about the user, their location, and specific information about the
plant area or project in question.

Information provided for the header tab will also be included on the reports generated by
FIRSTVUE™.

From this screen projects and specific plant locations can be identified by tag number.
Specific fields contained in this screen are as follows:

Project Information Field
Definitions

FIRSTVUE™ categorizes all sizing and selection
activity into projects for manageability. By default,
PROJECT1, Revision 00 is selected when the program
opened.

Project Name of particular project or plant area

Rev Revision number of the project in question

Date Today’s date, in number format set by Windows display
preferences. MM/DD/YY or DD/MM/YY

Create New Creates a new project by name given in Project field.

Open Existing Opens an existing project by querying all project files of a
certain name, revision number or between specific dates.

Description Brief description of project, 35 characters in length
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User Name Pull-down selection of users that have been added to
FIRSTVUE™. Information used for reports

Copy Item Allows copying one item from one project to another
project. Will ask for specific project to query to copy item
from.

Notes A free-form text note, these are useful for noting issues,
questions for specific tag numbers, and progress in project
related work. They are not tied to a specific item number,
but are visible from any item.

Save Saves the project to the Microsoft Access (.MDB) database
file. This can take a while if you have many items in your
project.

Cancel Cancels changes made before a save is done. It will not
cancel changes made after the Save command is
executed.

Supplied to You By The Supplied to You By data will typically already be
filled in when you receive your software from your local
representative. If needed, both the logo and the data
can be modified by accessing the FIRSTVUE™
directory or the FIRSTVUE.INI file, respectively.  For
specific information on this, see Chapter 4: Project
Management using FIRSTVUE™.

Name Representative name.

Loc Representative location/address.

Phone Representative phone number.

Fax Representative fax number.

E-mail Representative e-mail address.

Add/Edit User The Add/Edit User section allows the customer to
include their name for reference on sizing and
selection information and can be updated accordingly.

Name User first and last name

Company Company user works for

Loc Location of company, such as city, state.

Phone User’s phone number

Fax User’s fax number
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E-mail User’s e-mail address

Delete Deletes the selected user from the list of FIRSTVUE™ user
names

Update Update user information to reflect changes in phone,
location, etc.

Add Add a new user to the list of user names.
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Item List Tab
The item list tab is used when large projects are being handled by FIRSTVUE™. In this view,
the project can be sorted by item or tag number. When the See Compnt (Component) box is
selected, size and model information found in the description is displayed for each tag or item
number.
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Item Information Field
Definitions

Item No Item number as assigned by program in sequential order.

Alt Alternate item number for a specific unit. Useful for
comparing choices for a particular selection.

Tag User assigned tag number, used for control system
identification, as well as maintenance records.

Item Status of each individual item, either open, won, lost, or
cancelled. Default is open.

Description Brief description of valve selected, may include actuator.

Qty Quantity desired for that particular item number. Useful for
identifying tag numbers that are identical valves.

Day The number of European delivery days

Delivery Unit of time for delivery, such as hours, days, weeks or
months.

Spec The type of specification sheet required for the item.

Quote Status Changes all items to reflect changes in quote status, such
as open to won, etc.

Sort by Item/Tag Changes view to either alpha-numerically by item number
to alpha-numerically by tag.

See Compnt When selected, shows the first component of each item.
Shows size and model information from the description.
Useful to identify a particular valve if the tag number is
unknown.

Tag Displays an option box to allow adding tag numbers to a
particular item. Used when more than one valve has
identical process conditions. Tags can also be updated,
deleted or added with this selection.

Ext Price Total Sums the total price for the project based on information
received from your local Fisher representative by
exchanging .FFV files.

Add Adds another item to the item list.

Delete Deletes a selected item from the item list.
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Copy Copies an item from another project.

Cancel Reverts order status and tags back to original values when
tag was entered.

Information generated by a user can be easily transferred to your local Fisher representative
by saving the file using the Save As .FFV option. This electronic transferal of data allows your
Fisher representative the ability to review all sizing and provide the user with a quotation
based on the information provided.
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Sizing Tab
 FIRSTVUE™ offers a complete sizing engine for control valves, actuators, and monitors.
Initial sizing estimates, called Quick Sizing is possible, as well as specific cases. Sizing
information can be displayed in spreadsheet mode or as one condition results. The Sizing Tab
appears as follows:

Condition Summary Field
Definitions

Valve Type Valve type model number selected based on flow and
pressure class requirements.

Actuator Actuator model number selected to provide necessary shut
off and actuation force

Actuator Size Specific size of actuator model selected

Spring Specific spring needed to provide actuation forces in spring
and diaphragm actuators

Import FSP file Allows import of sizing information of FSP 1.42 (Fisher
Sizing Program) files only. It does not allow for specification
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sheet input from FSP 1.42.

Condition Up to ten conditions are possible, updated in the condition
maintenance selection.

Flow Coefficient Flow coefficient calculated for each process condition to
pass required amount of fluid.

Valve LpA Noise estimate of fluid flow, pertains to gas sizing only.

Warnings Warnings issued by the sizing program to identify areas of
concern, such as noise, cavitation, flashing, etc will be
displayed as a Y if warnings are present. Press Warnings
button to display any warnings present.

Select All Selects up to four process conditions for viewing in the
spreadsheet mode.

Deselect All Removes selection of all process conditions to allow for
specific condition viewing in spreadsheet mode.

Sizing Config Allows selection of units of measure for pressure, gas flow,
vapor flow, liquid flow, temperature, mass (gas), density,
area, length, force, velocity, spring rate, viscosity, torque
and atmospheric pressure. Choices can also be made to
have either all English or Metric conventions.

Flow Coeffs Sizing information for Fisher control valves are displayed for
the selected process conditions. The user can select
between viewing all Cv data, or just those that pertain to the
flow coefficients calculated.

Condition Maintenance

New Allows addition of another flow coefficient, up to ten
maximum.

Rename Renames highlighted condition to another name.

Copy Copies process conditions from one condition to another.

Delete Deletes the highlighted process condition.

Clear Clears either all information for highlighted conditions or just
valve, actuator, or monitor sizing information.

Sizing Views

Quick Basic sizing for liquids, ideal gas or vapor. Fluid information
of liquids and ideal gas based on published critical
pressure, vapor pressure and specific gravity. Useful to
identify range of flow coefficients required to pass flow.
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Spreadsheet Displays sizing information in spreadsheet format for
highlighted process conditions. Useful to identify flow range
required, as well as how changes in process conditions
affect valve performance and requirements.

Schematic A visual method of valve sizing showing pressure drop, flow
and fluid information schematically. Uses same sizing
methodology as the quick sizing approach.

Rotary Act Sizing of rotary actuator based on valve selected on same
screen. Calculates torque based on actuator orientation and
preferences.

S.S. Act Sizes sliding stem actuator to match selected control valve.
Calculates forces required, and can also select actuators
automatically if needed.

Speed Calculates fill and relief times associated with actuator
selected. Identifies if quick release valves and other
accessories are needed to provide fail-safe operation.

Monitor Calculates flow rates required for proper monitor operation.
A monitor configuration, essentially two regulators piped in
various configurations, provides downstream overpressure
protection by controlling intermediate pressure between the
two regulators.

LpA vs Q A tabular view of flow and corresponding noise level
predictions. This view is useful in sizing diffusers or other
methods of controlling noise due to process flow.

Warnings A summary of all warnings associated with the process
conditions highlighted.

Item Specific Information

Item Item number as assigned by program in sequential order.
May be alpha-numeric and can be modified in this field.

Qty Quantity requested for the particular item.

Combo box Contains list of tags and item numbers.

Tag User assigned tag number, used for control system
identification, as well as maintenance records.

Spec Sheet Specification sheet generated upon request based on the
default spec selection, either ISA or Fisher based. Further
selections can be made to reflect sliding stem, rotary,
regulator, and diffuser choices.
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Default Spec (ISA/Fisher) Provides either an ISA or Fisher specification sheet,
depending on user preference. Only used the first time that
a spec sheet is entered for an item.

Add Item Adds an additional item to the project to the end of the
project.

Delete Item Deletes the selected item and requires confirmation of the
deletion.

Regulator Calculates regulator flow requirements in a tabular format.

Copy Tag Enables copying of flow sizing and selection data to another
item in the same project. The tag number must be modified
before the OK portion of the command is enabled.

Notes Free form note field for actuator, valve sizing or stroking
speed information.

Cancel Returns screen information to information present when the
sizing tab was first selected.

 Pull Down Menus
FIRSTVUE™ offers traditional Windows functionality by means of pull-down menus
accessible throughout all tabs and views as well as icons visible from every screen. Cutting,
pasting and copying is possible within FIRSTVUE™, as well as jumping from one project to
another via the Window option.

File

New (Model On) Models a new project on a project in the
database. Existing project can be accessed by
using the query button.

New Project Opens a new project.

Open (Database) Allows user to open a project from the database.

Save to Database Saves project information to FIRSTVUE.MDB
database for use by FIRSTVUETM or Microsoft Access
or Excel applications.

Open FFV File Opens .FFV (First First Vue) file format.

Save to FFV File Saves project in .FFV (First First Vue) format to allow
for electronic quotation with local Fisher
representative or saving data to a network.
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Delete from Database Allows deletion of project from database.

Close Project Closes current project and prompts for saving
changes.

Import ISA File Allows importation of .BSV (Bar separated value) file
formats from Intergraph’s IDMTM software.

Export ISA File Allows export of .BSV (Bar separated value) file
formats to Intergraph’s IDMTM software.

Edit ISA Map File Edits field ordering for ease of import/export flexibility.

Reports Allows additional report options, such as summary,
sizing calculations, print warnings, and custom
headers and footers for all or specific item numbers.

Print Setup Basic print setup information, such as printer
selection, default printer, paper orientation, and paper
location.

Exit Exits FIRSTVUE™ software package.

Edit

Cancel Changes Context specific cancellation of changes.

Cut Cut data, for moving purposes <Ctrl X>.

Copy Copy data, or use shortcut <Ctrl C>.

Paste Paste data, or use shortcut <Ctrl V>.

Delete Deletes data.

Tabs

Header Project header information <Ctrl 1>.

Item List Detailed information by item or tag number <Ctrl 2>.

Sizing Sizing information by item or tag number <Ctrl 3>.

View

Tool bars Toggles tool bar.

Status bar Toggles status bar.

Tab bar Toggles tab bar.
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Window Allows selection between open project files.

Help

Content Hypertext links to specific FIRSTVUE™ topics of
interest.

Search Allows keyword searches for specific topics.

Using Help Provides help on Windows specific information

About FIRSTVUETM Provides software version number, as well as
copyright information.

Shortcuts and Hints
Several shortcuts exist that can improve the efficiency of a user. Of particular note is the use
of <Ctrl C> pushed simultaneously to copy and <Ctrl V> to paste.

Another hint that makes the sizing program easier to use is the use of the caret and yellow
highlighted fields visible on the spreadsheet sizing view. When the caret appears, that
indicates a field that can be changed from user supplied to calculated or system supplied
information. The yellow highlighting denotes fields that are calculated. For example, if flow
rate is provided, Cv can be calculated. Also, a single click on a field can change the
parameters associated with that value, such as toggling between pipe size and schedule and
pipe diameter and thickness information.

The Import FSP button on the Sizing Tab only imports sizing data, not specification data from
FSP 1.42.

Notes are very useful to expand on explanation of product, location, needs, etc.

Use extreme caution when changing Atmospheric Pressure when sizing data has already
been entered on one or more items. All sizing data can be lost if care is not taken in this area.
To not lose sizing data, highlight the entire spreadsheet, hit <Ctrl C>, go to the Sizing Config,
change the Atmospheric Pressure, and press OK, go to the sizing spreadsheet and hit <Ctrl
V>, Otherwise, you risk losing all calculated data due to the change in atmospheric pressure.
This copying and re-pasting of spreadsheet information will enable atmospheric pressure
changes without having to re-key all valve related information. This process must be done on
an item by item basis.
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Program Overview Diagram
The map of the FIRSTVUE™ sizing program is as follows:

FIRSTVUE
Program Header

Screen

Item List Tab

Sizing Tab

Project Description Add/Edit User

Item Tags

Add/Delete/Copy
Item

Item Tags

Condition Maintenance

Reports and Spec
Sheets

Add/Delete/Copy
Item

Copy Tag

Flow Coefficients

Sizing Configuration

Import FSP
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Chapter 3: Sizing and Selection Using
FIRSTVUE™
In the last chapter, you saw an overview of the FIRSTVUE™ software. In this chapter, you will
begin to use the powerful sizing engine contained within FIRSTVUE™ for sizing valves,
actuators and monitors. Selection of products and inserting sizing notes will also be covered.

This chapter contains the following sections:

• Sizing a Valve

 Entering and Selecting Process Conditions

 Using the Quick Valve Sizing Screen

 Using the Schematic Sizing Screen

 Using the Spreadsheet Sizing Dialog Box

• Selecting calculated fields

• Changing default field data

• Setting Sizing preferences

• Viewing Warnings

• Viewing a Table of Noise versus Flow

• Selecting a Control Valve

• Sizing an Actuator

 Sliding Stem Actuator Sizing

 Rotary Actuator Sizing

• Checking the Stroking Speed of an Actuator

• Sizing Monitors

• Inserting Sizing Notes

Sizing a Valve
FIRSTVUE™ gives you several options for sizing a valve, depending on the amount of
information you have and the level of detailed calculations you need.

This section contains instructions for using the main sizing screens or options for valve sizing.
It consists of the following sections:

• Entering and Selecting Process Conditions
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• Using the Quick Valve Sizing Screen

• Using the Schematic Sizing Screen

• Using the Spreadsheet Sizing Dialog Box

Entering and Selecting Process Conditions

FIRSTVUE™ lets you enter up to 10 sets of process conditions for each item.

To name and select sets of process conditions, you use the Sizing Screen. To display the
Sizing Screen, click the Sizing Tab.

Here is an example of the Sizing Screen:

The Sizing Screen lets you select sets of process conditions, and then navigate to other
screens on which you enter data for each set of conditions. When done entering data on other
screens and dialogs, the results are calculated and then displayed on the Sizing Screen.

To fill in the Sizing Screen:

1. In the Item#:Tag1 field, enter or select the item, if not already selected. Once you select
the item, the screen displays data previously entered for it.

2. Select one or more sets of process conditions.
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 The spreadsheet area of the Condition Summary section displays process conditions
you can select for your calculations.  Minimum, Normal, Maximum, and Other are the
default condition names.

 You can add a new condition, rename, delete, copy, or clear all conditions by clicking on
the appropriate Condition Maintenance buttons.

 Click a condition to select it or click the Select All or Deselect All buttons to select or
deselect all conditions respectively. A condition is highlighted when it is selected. You can
select up to 10 process conditions.

NOTE: You must select at least one condition to access other screens and dialogs.

Once you select a process condition, the Sizing Views buttons along the right side of the
screen become active, giving you access to other sizing screens.

FIRSTVUE™ offers three screens used in sizing valves:

• Quick Valve Sizing Screen—Lets you calculate the flow coefficient, for one condition.

• Schematic Sizing Screen—Lets you calculate the outlet pressure, flow, or flow
coefficient for one condition.

• Spreadsheet Sizing Dialog Box—Lets you do detailed calculations for multiple
conditions at one time.

The following sections contain instructions for using the valve sizing screens.

Using the Quick Valve Sizing Screen

The Quick Valve Sizing Screen lets you enter basic information for one process condition,
and then calculates and displays the flow coefficient for that condition. You can repeat this
procedure for any number of process conditions.

To display this screen, click the Quick button on the Sizing Screen.
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Here is an example of the Quick Valve Sizing Screen for liquids:

To fill in the Quick Valve Sizing Screen:

1. Select a fluid by clicking on the appropriate radio button: Liquid, Ideal Gas, or Vapor.

 Once you select a fluid, the screen displays entry fields for the corresponding fluid
properties, service conditions, and valve specifications.

2. Fill in the rest of the screen by typing the conditions in the appropriate fields, and
selecting from the drop-down lists. If allowable pressure drop needs to be calculated,
leave the dP field blank and click Calculate.

3. When done, click the Calculate button. The program then calculates and displays the
results.

4. Click the Close button to display the Sizing Screen.

Using the Schematic Sizing Screen

The Schematic Sizing Screen lets you enter information for one process condition, and then
calculates and displays your choice of the flow coefficient, flow, or outlet area. You can repeat
this procedure for any number of process conditions.

To display this screen, click the Schematic button on the Sizing Screen.
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Here is an example of the Schematic Sizing Screen for liquids:

To fill in the Schematic Sizing Screen:

1. Select a fluid by clicking the appropriate radio button: Liquid, Ideal Gas, or Vapor.

 Once you select a fluid, the screen displays entry fields for the corresponding fluid
properties, service conditions, and valve specifications.

2. Select a calculation field. To do this, click the radio button of the field you wish calculated:
P2 (Outlet Pressure), Q (Flow), or Cg or Cv (Flow Coefficient for Gas or Vapor).

3. Fill in the rest of the screen by typing the conditions in the appropriate fields and selecting
from the drop-down lists.

4. When done, click the Calculate button. The program calculates and displays the results.

5. To display the Sizing Screen, click the Close button.

Using the Spreadsheet Sizing Dialog Box

The Spreadsheet Sizing Dialog Box lets you enter detailed data for one or more process
conditions. To display this dialog, select one or more conditions and click the Spreadsheet
button on the Sizing Screen.
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Here is an example of the Spreadsheet Sizing Dialog Box for Liquid:

The Spreadsheet Sizing Dialog Box  lets you enter detailed information for the process
conditions you selected on the Sizing Screen.

To fill in the dialog:

1. Select a fluid by clicking the appropriate radio button on the left side of the screen.  Once
you select a fluid, the screen displays entry and calculations fields for that fluid.

NOTE: The TwoPhs GL radio button refers to gas/liquid two-phase flow sizing. The
TwoPhs VL radio button refers to vapor/liquid two-phase flow sizing.

2. Select calculated fields by clicking in the second column of the appropriate fields to
display the > symbol. Calculated fields are also denoted by the yellow highlighting.

 The second column is either blank, indicating the field accepts  entry, or contains the >
symbol, indicating the program calculates and displays the results in that field.

 You can select whether the program calculates Cv (Flow Coefficient), Q (Fluid Flow
Rate), or dP (Valve Pressure Drop). For example, to calculate the dP, click in the dP
calculation column to display the > symbol and then enter the flow rate and flow
coefficient in the Q and Cv fields.

3. Select the units of measurement for each field, if desired.
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The third column of the dialog displays the default units of measurement for each field.
Changing default field data is done by selecting from the drop-down lists to overwrite
the defaults.

NOTE: Downstream piping information can be toggled between Downs Pipe Size/Downs
Pipe Sched to Downs Pipe O.D./Downs Pipe Thick by simply clicking the mouse on one of
those fields.

4. Enter the process data.

The fourth through thirteenth columns contain entry fields for each process condition you
selected on the Sizing Screen. To fill in these fields, type or select from drop-down lists,
depending on the field and fluid.

NOTE: The Spreadsheet Dialog Box displays four process conditions at a time. To enter
information for additional process conditions, you must select them on the Sizing Screen and
then return to the Spreadsheet Dialog Box.

5. To view a table of noise versus flow for a process condition, click the LpA vs Q button for
that condition. You can include the table of noise versus flow in your spec sheets.

6. To calculate velocity, select the Upstream Area and Downstream Areas valve sizes by
selecting from the drop-down lists, and then type data in the condition cells of the
spreadsheet.

7. The Valve Incr. Velocity section lets you predict noise of the valve with velocity higher
than the standard guidelines allow. For assistance, contact your Fisher Salesperson.

8.  For gas, vapor, or steam calculations that require additional noise attenuation

a. Scroll down the Spreadsheet view until the diffuser information section is visible.

b. Choose a diffuser for each set of conditions by selecting from the drop-down lists.

c. In the Diffuser Incr. Velocity section, in the Actual Outl. Area field, type the actual
outlet area in each cell, if necessary.

d. Click the Calculate button.

The program calculates and displays the noise levels.

The program may show different diffuser Cgs required for different process
conditions. However, since a diffuser is a fixed device, it can have only one Cg.
Therefore, you need to recalculate using the highest diffuser Cg displayed. To do this:

i. Click the second (calculation) column of the Diffuser Cg row to remove the >
symbol.

ii. In each cell of the Diffuser Cg row, enter the highest diffuser Cg previously
calculated.

iii. Click the Calculate button.

The program recalculates and displays the accurate noise levels for the diffuser Cg.

9. When done entering conditions, click the Calculate button. The program calculates and
displays the results.
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To return to the Sizing Screen, click the Close button. The Sizing Screen displays the
results of your entries and calculations.

Setting Sizing Preferences
You can set defaults for the units of measurement displayed  throughout FIRSTVUE™. To do
this, you use the Sizing Configuration Dialog Box. To display this dialog, click the Sizing
Config button on the Sizing Screen.

Here is an example of the Sizing Configuration Dialog Box:

The Sizing Configuration Dialog Box displays the system defaults for units of measurement
and atmospheric pressure. You can overwrite the default units of measurement on a field-by-
field basis on any data entry screen.

The Sizing Configuration Dialog Box allows you to reset the system defaults to units of
measurement you use most frequently, and allows you to change the atmospheric pressure
used in the program’s calculations. It offers the following options:

• To change system defaults for individual fields, select from drop-down lists in each field.

• To change all the system defaults to English measurements, click the All English button.
To change them to metric measurements, click the All Metric button.

• To change the atmospheric pressure, type in the Atmospheric Pressure field.

NOTE: Changing the atmospheric pressure will clear any calculations made with the
previous atmospheric value!!
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NOTE:  To change the atmospheric pressure value for valves already sized without re-
keying the process conditions, do the following: Highlight the specification sizing sheet data
and use <Ctrl C> to copy it into the clipboard memory. Then, change the atmospheric
pressure, go back to the spreadsheet and paste, using <Ctrl V>, and then calculate.

• To erase your entries and revert to the previous system defaults, click the Default button.

• To save your entries, click the OK button. This creates new defaults for the program. You
can still revert to the built-in system defaults by clicking on the Default button. To
overwrite  the built-in system defaults with your entries, click in the Save Units As User
Default check box.

• When you click the OK button, the Sizing Screen appears.

Viewing Warnings
FIRSTVUE™ issues warnings if a process condition exhibits cavitation, flashing, noise,
excess velocity, or other conditions requiring attention. To view warnings, click the Warnings
button on the Sizing Screen. The program then displays a series of dialog boxes showing
warnings for each process condition. The user can also select if the warnings issued by
FIRSTVUE™ will be included on specification sheet reports.

Viewing a Table of Noise versus Flow
You can view a table of noise versus flow for each process condition in your case, and print
the table on your spec sheets. To do this, you use the LpA vs. Q Table. To display this table,
click the LpA vs. Q button on either the Sizing Screen or the Sizing Spreadsheet. Both
methods display the table.
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Here is an example of the LpA vs. Q Table:

The LpA vs. Q Table displays a spreadsheet of noise, Cv, and flow at different percentages
of flow. This table is display only. To print the table for this condition on your spec sheet, click
the Print on Report button. You must repeat this process for each condition you want the
table to be printed on your spec sheet.

This table assumes a constant pressure drop and inlet pressure across the control valve
and/or control valve + diffuser. Therefore, care should be taken to ensure correct noise
abatement selections for all process conditions.

To return to the Sizing Tab, either click on the “X” in the upper right hand corner of the LpA
vs Q box, or press <Escape>.
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Selecting a Control Valve
Once you have determined the flow coefficient, you can select a valve size and type. To find
which control valves can pass the required calculated flow, click on the Flow Coeff’s button
on the Sizing Tab.

The Flow Coefficient Catalog Dialog Box lets you view flow coefficients for control valves
contained in Fisher Catalog 10 (Fisher standard equation) and Catalog 12  (ISA standard
equation). You can view whole pages of the selected catalog, or you can view just those
selections that meet your criteria for valve style, type, and flow coefficient.

To display this dialog, click the Flow Coeff’s button on the Sizing Screen. To view only those
control valves that meet your calculated flow requirements, select Hits Only.

Restricted trim sizes are shown in the blue shaded rows. Full port valve flow coefficients are
shown in the white rows.
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The Flow Coefficient Catalog Dialog Box consists of two views. The first (entry) view lets
you enter criteria for valve selection and displays a spreadsheet of selections based on your
criteria. You then double-click on a selection to show the second view of the screen, which
displays an actual catalog page.

The second view lets you select a valve, and view and print a graph of the valve’s flow
coefficients. To select a valve from the second (catalog) view, you double-click on it and then
click the Select button.

To fill in the first (entry) view of the Flow Coefficient Catalog Dialog Box:

1. Select the catalog you wish to view by clicking the Fisher equation (Catalog 10
equivalent) or ISA equation (Catalog 12 equivalent) radio button in the Equation box.

2. Fill in the Style and Type fields by selecting from the drop-down lists. You can further
modify your conditions as follows:

a. To specify whether measurements are shown in inches or millimeters, click the
Inches or mm radio button in the Units box.

b. To specify the data displayed, click the Cv, Cs, and/or Cg radio buttons in the Data
Displayed box to select them. You can select any or all of them.

3. When done, double-click a selection to display the second (catalog) view of the dialog
box.
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The second view of the Flow Coefficient Catalog Dialog Box displays the catalog page
resulting from your valve criteria, lets you select a valve, and lets you view and print a graph
of the valve’s flow coefficients.

The dialog displays the valve type, class, trim style, etc. you selected. You can change these
attributes only on the first view of the Flow Coefficient Catalog Dialog Box. To display the
first view of the dialog, click the Back button.

The Display box shows the catalog page for the conditions selected. The bulletin number
describing the valve appears just below this box. Notes pertaining to valve construction and/or
sizing, also found in Catalogs 10 and 12, appear in the Notes box. You can scroll to view the
full 10%-100% range of the valve characteristics.

To use the Flow Coefficient Catalog Dialog Box:

1. Select a process condition in the Calculated Flow box by clicking on it. A process
condition is highlighted when it is selected.

NOTE: You can collapse the display to show only the valve and port size combinations that
meet the selected process condition. To do this, click the Hits Only radio button. To reset the
catalog display to show all port sizes, travels, etc., click Reset Catalog Display in the
Calculated Flow box.

2. To view a graph of flow coefficients for the selected valve, double-click on a valve to
select it, and then click the Graph button.
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To print the resulting graph, you must copy it to your clipboard, paste it into a word
processor, page layout, or graphics application, and then print it. You cannot print the
graph directly from FIRSTVUE™.

3. To select a valve, double-click on it and then click the Select button. The Sizing Screen
appears, displaying the results of your selection.
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Sizing an Actuator
Sizing of both sliding stem and rotary actuators is possible with FIRSTVUE™.

Sliding Stem Actuator Sizing

To size a sliding stem actuator for your control valve, you use the Sliding Stem Actuator
Sizing Screen. To display this screen, click the S. S. Act button on the Sizing Screen.

Here is an example of the Sliding Stem Actuator Sizing Screen for a spring and diaphragm
sliding stem actuator:

The Sliding Stem Actuator Sizing Screen  offers two ways to size:  Automatic and Manual.
In Automatic sizing, you enter data, and based on that data, select an actuator. In Manual
sizing, you enter the actuator size and spring and the program calculates and displays the
data based on your entry. You use Manual sizing when you have an actuator in mind and
want to know if it meets your criteria.

The program displays the Automatic view by default. To display the Manual view, click the
Automatic button, which toggles between Automatic and Manual views. Then, fill in the
Actuator Size and Spring fields from the drop-down lists.
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To fill in the Sliding Stem Actuator Sizing Screen in Automatic view:

1. Select the Sizing Type (Spring & Diaphragm, Spring & Piston, or Piston) by clicking on
the appropriate radio button.

2. Select an Actuator Type and Valve Design from the drop-down lists.

 Once you select the Sizing Type and Actuator Type and Valve Design, the screen
displays fields appropriate to your selections.

3. To select a sliding stem actuator for a valve with bellows, click the Bellows check box.
The Bellows Dialog Box appears, allowing you to enter relevant data.

4. Select a Sizing Method (Quick, Detailed, or Catalog 14) by clicking the appropriate radio
button. Each Sizing Method  displays a different view of the screen, with different entry
fields:

• Quick view lets you enter basic information, such as the body size, flow, trim, and
packing material.

• Detailed view requires detailed information, such as the numeric values of valve
travel, friction, and unbalanced area.

• Catalog 14 view requires the standard information used in Fisher Catalog 14—more
information than the Quick view and less than the Detailed view.

NOTE: You can start by entering information in Quick or Catalog 14 views and then click
the Detailed radio button to display the Detailed view. The information you enter in Quick or
Catalog 14 view is then translated into the correct numeric values and displayed in the
appropriate Detailed view fields. For example, when you enter a packing material in Quick
view, the corresponding numeric friction value for that packing material appears in Detailed
view.

4. Fill in the rest of the fields by typing or selecting from the drop-down lists.

5. When done, click the Calculate button.

 The Select Sliding Stem Actuator Dialog Box appears, displaying a list of sliding stem
actuators that meet your specifications. Each line of the dialog displays the actuator size,
the spring part number, and the spring rate.

6. Select an actuator by double-clicking on it.

The Sliding Stem Actuator Sizing Screen appears. The right side of the screen displays
thrust data from the actuator size you selected.

NOTE: If you want a non-standard product, you must manually override the data displayed.
To do this, click the Detailed radio button to display the Detailed view. Then, overwrite the
appropriate fields with your exact data. For example, if you entered a non-standard port in the
Quick view, after selecting a sliding stem actuator you need to change the port diameter in
Detailed view. When done, click the Calculate button to recalculate based on your entries.

7.  When done, click the Close button. The Sizing Screen appears, displaying the sliding
stem actuator, actuator size, and spring you selected.
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Rotary Actuator Sizing

Here is an example of the Rotary Actuator Sizing Screen for a spring and diaphragm rotary
actuator:

To fill in the  Rotary Actuator Sizing Screen:

1. Select an actuator model number from the drop-down list at the top of the screen.

2. If you are using the actuator with a V250 control valve, click the With V250 check box.

 The screen displays entry fields for your selected actuator model number.

3. Fill in the fields on the left side of the screen, either by typing or selecting from drop-down
lists:

• In the TD (Dynamic Torque) field, enter the dynamic torque, based upon the valve
construction and effective pressure drop.

• In the TB (Breakout Torque) field, enter the breakout torque, based upon the friction
factors of the control valve and the shutoff pressure drop.

NOTE: To use FIRSTVUE™’s built-in torque calculation screen, click the Torque Calc
button.

4. When done, click the Calculate button.
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 The Select Rotary Actuator Dialog Box appears, displaying a list of rotary actuators
that meet your specifications. Each line of the dialog displays the actuator size, the spring
part number, and the spring rate. For 1051 series, the screen also displays the seat
number.

5. Select an actuator by double-clicking on it.

 The Rotary Actuator Sizing Screen reappears. The right side of the screen is filled in
with torque data from the actuator size you selected.

6. Compare the required torque entered on the left side of the screen with the available
torque on the right side of the screen to be sure the actuator size you selected has
adequate capacity. If not, click the Calculate button to display the Select Rotary
Actuator Dialog Box and select a different actuator.

7. When done, to display the Sizing Screen, click the Close button. The Sizing Screen
displays the actuator, actuator size, and spring you selected.

Checking the Stroking Speed of an Actuator
To calculate the stroking speed of actuator, you use the Stroking Speed Sizing Screen. To
display this screen, click the Speed button on the Sizing Screen.

Here is an example of the Stroking Speed Sizing Screen for a spring and diaphragm
actuator:
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To fill in the Stroking Speed Sizing Screen:

1. Select a stroking option by clicking on the appropriate radio button: Spring Diaphragm,
Spring-Return Piston, or Piston.

 Once you select an option, the screen displays data entry fields for that option.

2. Fill in the fields on the left side of the screen by typing or selecting from drop-down lists.

NOTE: You must enter accurate figures for the initial and final filling stroking pressures (Pi
Fill and Pf Fill fields), and initial and final exhausting stroking pressures (Pi Exhaust and Pf
Exhaust fields). For equations used to calculate these figures, see the on-line Help topic,
“Valve Sizing Supplemental Information.”

3. Fill in the Air Cv Fill field with the combined flow coefficient of the filling air supply
apparatus.

You need to enter the combined Cvs of each apparatus in the air supply line to the
actuator. To calculate the combined Cvs:

a. Click the Combined Cv Calculation radio button to display a Cv calculation
worksheet.

b. Enter the Cv for each apparatus.

c. Click the Calculate button.

The Calculated Results Dialog Box appears, displaying the combined Cv. You need
to make a note of this figure or copy it to the clipboard; the program does not copy it
automatically to the proper field.

d. When done, click the appropriate radio button (Spring Diaphragm, Spring-Return
Piston, or Piston) to display the screen you wish.

e. Type the combined Cv in the Air Cv Fill field.

4. Fill in the Air Cv Exhaust field with the combined flow coefficient for the exhaust
apparatus. To calculate the combined Cv for the air exhaust apparatus, repeat steps 3a—
3e, using Cv’s for each apparatus in the exhaust line.

5. Click the Calculate button. The calculated results appear on the right side of the screen.

6. When done, to display the Sizing Screen, click the Close button.

Sizing Monitors
FIRSTVUE™ lets you calculate the intermediate pressure, flow coefficients, and flow capacity
for monitoring systems.  This chapter contains instructions for using FIRSTVUE™ for your
monitor sizing calculations.

To size monitors, you use the Monitor Sizing Screen. To display this screen, you click the
Monitor button on the Sizing Screen.
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Here is an example of the Monitor Sizing Screen:

The Monitor Sizing Screen lets you calculate intermediate pressure, flow coefficients, and/or
flow rate of your monitoring system.

To fill in the Monitor Sizing Screen::

1. Select the calculation option by clicking on the appropriate radio button:

• To calculate the intermediate pressure and flow coefficients for both the monitor and
worker, click Pi/Cg.

• To calculate the intermediate pressure and flow rate for the monitor system, click
Pi/Q.

• To calculate the flow rate and flow coefficient when you know the intermediate
pressure, click Q/Cg.

 Once you select a calculation option, the screen displays the appropriate entry fields.

2. Enter data all in the fields except the fields you want the program to calculate. For
example, if you selected the Pi/Cg option, enter information in every field except the Pint
(Intermediate Pressure) and CgA and CgB (Flow Coefficients for regulators A and B)
fields.

3. When done, click the Calculate button. FIRSTVUE™ calculates and displays the results.

4. When done, to display the Sizing Screen, click the Close button.
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Inserting Sizing Notes
FIRSTVUE™ allows the user the ability to add notes to each individual item for clarification
and quotation purposes. These notes are added to the Valve Sizing Report, Actuator Sizing
Report, and the Stroking Speed Sizing Report. Only one note is allowed for each item.

To add sizing notes:

1. Click the Notes button on the Sizing Screen.

 The Sizing Notes Dialog Box appears:

To add a new note:

1. Select the type of note you want to add from the Note Type drop-down list.

2. Click the New Note button.

3. Type your note in the Note Text field.

4. Click OK.

FIRSTVUE™ saves your note. The Sizing Screen appears.

To update a note:

1. Display the note on your screen by selecting from the Note Type drop-down list.

2. Click the Update button.

3. Type your changes in the Note Text field.

4. Click OK.

FIRSTVUE™ saves your changes. The Sizing Screen appears.
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Chapter 4: Project Management Using
FIRSTVUE™
We call each FIRSTVUE™ record a Project. A Project can contain one or more items—
valves, actuators, monitors, etc. Your Fisher Representative uses the data files, spec sheets,
and reports from  FIRSTVUE™ Projects, saved in .FFV file formats, to provide you with
accurate and timely price quotations.

When you create a new Project, you assign a Project number and include the name and
address of your company contact and other information identifying the Project. When you
save a Project, the program stores it in the MS Access database within the program. When
you open the Project, the program loads it and displays its data in FIRSTVUE™ screens.

This chapter contains instructions for working with projects and items. It contains the following
sections:

• Creating a New Project

 Adding, Changing, and Deleting User  Information

 Filling in Project Information

• Changing “Supplied to You By” Information

• Opening an Existing Project

• Modeling a New Project on an Existing Project

• Working with Items

 Adding a New Item

 Copying an Item

 Finding an Item

 Deleting an Item

 Adding, Changing, and Deleting Item Tags
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Creating a New Project
To create a new Project, you use the Project Header Screen. To display a blank Project
Header Screen, select New Project from the File Menu.

NOTE: If the Project Header Screen is already displayed, you can click the Create New
button to display a blank Project Header Screen.

Here is an example of the Project Header Screen:

The
Project Header Screen lets you identify the Project with a Project number, contact
information, and other information.

Information you enter on this screen prints on your spec sheets and reports. You can use this
information later to find and display the Project.

The Supplied to You by box displays the name, address, phone numbers, and e-mail
address of your Fisher Representative.

To complete the Project Header Screen, you enter the name and address information of the
person in your company to contact about the project, and enter information identifying the
Project.

Adding, Changing, and Deleting User Information

The Project Header Screen contains an address book in which you can store information
about your company contacts, or users.

To select a user from the address book, you select from the drop-down list in the User box.
The user’s name then appears in the Current field, and their address, phone, and email
information appears in the Company box.
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The following sections describe how to add, change, and delete users from the address book.

Adding a User

To add a user to the address book:

1. In the Current field, type the contact’s name.

2. In the Company box, enter your company or division name, location, phone, fax, and
email address in the appropriate fields.

3. Click the Add button in the User box.

The program saves the contact information.

Updating User Information

To change or update information about a user:

1. Select the user from the drop-down list.

2. Type over the information you wish to change.

3. Click the Update button in the User box.

The program saves your changes.

Deleting a User

To delete a user from the address book:

1. Select the user from the drop-down list.

2. Click the Delete button in the User box.

The program deletes the user.
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Filling in Project Information

To fill in Project information:

1. In the Project box, type the Project number. You can assign any combination of 10
numbers or characters to identify the Project.

NOTE: Project numbers must be unique. If you assign a duplicate Project number, when you
save the new Project the program will overwrite the ‘old’ Project with your new information.

2. In the Rev field, type the revision ID. You can type two numbers  or characters to identify
the revision.

3. Fill in the Date field as follows:

• Type the date in the MM/DD/YY format. For example, to enter November 26, 1998,
type: 11/26/98. The program will default to the date format preferences established in
Windows’ settings, making DD/MM/YY formats possible.

 — OR —

• Double-click on the Date field to display the Calendar Dialog Box. Then, use your
mouse to select a year, month, and date.

4. In the Description field, type a brief description of the Project.

5. When done, to save the Project:

• Select Save from the File Menu.
 — OR —

• Press Control + S.
 — OR —

• Click the Save button.

Changing “Supplied to You By” Information
The Supplied to You By data will typically already be filled in when you receive the software
from your local Fisher representative. If modifications are needed, make them in the
FIRSTVUE.INI file found in c:\Windows\.

Once FIRSTVUE™ is installed, the FIRSTVUE.INI file is copied to the Windows directory.
“Supplied to You By” data can be edited in the FIRSTVUE.INI file located in c:\Windows\.  The
FIRSTVUE.INI file in the FIRSTVUE™ directory is detached from the working copy of
FIRSTVUE™ - revisions to it will only take effect if they are made before installation.

Opening an Existing Project
To open an existing Project, you use the Project Search Dialog Box. To display this dialog:

1. Select Open from the File Menu.
 — OR —

 Click the Open Existing button on the Project Header Screen.

The Project Search Dialog Box appears:
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The Project Search Dialog Box lets you search for a Project by Project ID # or by date.

2. To find a specific Project, fill in the appropriate fields and click the Query button.

The Project Search Results Dialog Box appears:

The Project Search Results Dialog Box lists Projects that match your search criteria.

3. To select a Project, click on it to highlight it and then click the Open button.

The selected Project loads into FIRSTVUE™. The Project Header Screen appears, filled in
with data from the selected Project.

Modeling a New Project on an Existing Project
You can select an existing Project as a model for a new Project.

To do this:

1. Click Open Existing button on the Project Header Screen.

The Project Search Dialog Box appears.

2. Find and select the Project you want to use as a model. For complete instructions, see
the previous section of this chapter.
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3. Once you select the Project, the Project Header Screen appears, filled in with data from
the selected project.

4. Type a new Project ID # in the Project box.

Changing the Project ID # creates a new record in the FIRSTVUE™ database. Your new
record contains all the data from the previous Project, including any valve, monitor, and
actuator sizing information previously entered. You can now change any information you
wish.

Working with Items
Each Project can contain any number of items. Each item can have up to two components;
Component A, usually the valve body, selected from Fisher Catalog 10 or Catalog 12; and
Component B, usually the actuator selected from your calculations.

NOTE: You can note additional components or accessories  on your spec sheets. For more
information, see Chapter 6: Creating Specification Sheets and Reports

In this section, you will learn how to add, find,  and delete  items from a  Project. In the
chapters that follow, you will learn how to size valves or items, and select components for
them.
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Adding a New Item

When you add a new item, FIRSTVUE™ appends it to the current  Project. To add an item to
a Project:

1. Open the Project if it is not already open. For instructions on opening a Project, see the
previous section of this chapter.

2. Display the Sizing Screen by clicking on the Sizing Tab.

The Sizing Screen appears:

2. Click the Add Item button.

3.  A blank Sizing Screen appears. The number shown in the Item # Tag1  field increases
by one. For example, if your Project had four items previously, the new item number is
“5”.
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Copying an Item:

 To copy an item from another project:

1. From the Header Screen, select Copy Item.

2. The Project Query Dialog Box appears. Enter project name, revision, or date.

3. The results of the query will be as follows:

4. To copy particular item(s), highlight the item number from the right column.

5. Select Copy.

6. Item information now becomes part of the current project.

Finding an Item

To find an existing item:

1. Open the Project if it is not already open. For instructions on opening a Project, see the
previous section of this chapter.

2. Display the Sizing Screen by clicking on the Sizing Tab.

3. Select the item from the drop-down list in the Item # field.

Deleting an Item

To delete an item from a Project:

1. Open the Project if it is not already open. For instructions on opening a Project, see the
previous section of this chapter.

2. Display the Sizing Screen by clicking on the Sizing Tab.

3. Select the item from the drop-down list in the Item # Tag1 field.

4. Click the Delete Item button.
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Adding, Changing, and Deleting Item Tags

FIRSTVUE™ lets you identify items with tags—names or numbers that you assign to the item.
If your project contains more than one quantity of the same item, you can identify each item
with its own tag. Your tags print on spec sheets and reports.

To add, change, or delete tags, you use the Item Tag Dialog Box. To display this screen:

1. Open the Project if it is not already open. For instructions on opening a Project, see the
previous section of this chapter.

2. Display the Sizing Screen by clicking on the Sizing Tab.

3. Select the item from the drop-down list in the Item # Tag1  field.

4. Click the Tag button.

The Item Tag Dialog Box  appears:

The Item Tag Dialog Box displays the Project number and item number, and lets you add,
delete, and change tag names.

The cursor is active in the text box at the bottom of the dialog. To add a tag name:

1. Type the tag name. You can type up to 20 characters—letters, numbers, or special
characters.

2. Click the Add button. The tag name appears in the Tag Name box next to the tag unit
number.

3. If you have more than one quantity of an item, you can add tag names for each item. To
do this, repeat steps 1 and 2 for each tag name you want to add.

NOTE: To change a tag name, click on the tag name to select it, type the new tag name in the
text field, and then click the Add button. To delete a tag name, click on the tag name to select
it and then click the Delete button.

4. When done, click the Ok button.

 The Sizing Screen appears, displaying the tag name for the first item in the Item # Tag1
field.
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Adding Project Notes
Project notes let you add special shipping, packaging, and bar code requirements to your
project. Unlike sizing notes, which allow only one note per item, a project can have unlimited
notes associated with it.

To add project notes, use the Project Notes Dialog Box. To display this box, click the Notes
button on the Project Header Screen.

The Project Notes Dialog Box appears:

If the Project has any notes, the first one appears. You can browse notes within the Project by
clicking the First, Next, Previous, and Last buttons.

To update an existing note:

1.  Display the note on your screen by using the browse buttons.

2.  Click the Update button.

3.  Type your changes in the Note Text field.

4.  Click OK.

FIRSTVUE™ saves your changes. The Project Header Screen appears.
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To add a new note:

1. Select the type of note you want to add from the Note Type drop-down list. For
descriptions of the note types, see the table at the end of this section.

2. Click the New Note button.

3. Type your note in the Note Text field.

4. Click OK.

FIRSTVUE™ saves your note. The Project Header Screen appears.

To delete a note:

1.  Display the note on your screen by using the browse buttons.

1. Click the Delete button.
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Chapter 5: Import/Export Capabilities of
FIRSTVUE™
It is possible to import and export files from FIRSTVUE™ for use with different applications
and software packages. Specifically, the following will be discussed:

• Using .MDB File Formats

• Importing and Exporting .FFV File Formats

• Importing and Exporting .BSV File Formats

• Importing and Exporting ISA File Formats

• Exporting Dimensional Data

Using .MDB File Formats
When you save projects using the Save command or pressing <Ctrl S>, FIRSTVUE™
appends the data to the FIRSTVUE.MDB file in your FIRSTVUE™ directory. The .MDB file
format is a Microsoft Access file format. If you are proficient in designing Access queries and
reports, you can directly use the FIRSTVUE.MDB file for other uses. Since Access is a
Microsoft product, it can readily be transferred to and from Excel and Word.

Importing and Exporting .FFV File Formats
.FFV file formats allow  transferal of data from customer to representative and vice versa.
The .FFV format, an acronym for FIRST FIRSTVUE, is recommended when working on large
projects or when saving data to a network. .FFV file formats are also readily attached to e-
mail for discussion with your local Fisher representative regarding sizing issues or formal
request for quotation.

To save a project in .FFV format:

1. Select the File pull-down menu.

2. Select the Save to .FFV File option.

3. Follow the remaining instructions.

Importing and Exporting .BSV File Formats
Bar separated value (.BSV) flat file formats are very similar to comma delimited file formats,
except the character separating the fields is a vertical bar, “|”. In this file format, import and
export of FIRSTVUE™ data is possible to Intergraph’s Instrument Data Manager (IDMTM )
software.
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The interface between IDM™ and FIRSTVUE™ begins in IDM™. The IDM™ user inputs tag
numbers and other pertinent valve information. Then, the export file is translated via some
additional software into .BSV file formats. This information is then imported by the following
steps:

To import the “.BSV” file into FIRSTVUE:

1. Select Import ISA File from the FIRSTVUE file menu.

2. Select the file created in Step 5.

3. Click the Browse Map button

4. Select the “isa_all.csm” file.

5. Verify that the File Delimiter is set to “|”.

6. Click the Import button at the bottom of the window to start the import process.

7. As the import process runs, messages will appear in the Import Log.  If any error
messages appear, click the Save Log button when the import process is finished.  Enter
the name of a file to save the log to.

8. Click the Close button to close the window.

NOTE: FIRSTVUE imports items into the project you have open.  If you get the error
“Warning: No Active Document” it means that you don’t have a project open.  Open a project
and try again.

The FIRSTVUETM import process is “add-only”.  This means you cannot update existing items
via the import.  Imported items are added to the end of the open project.  For example, if you
are working in a project that already has 3 items, the first item you import will be set to item 4.
We recommend importing into a new project so that the first item you import will be item 1.

Data is imported into two places.  Sizing fields are imported into sizing.  Non-sizing fields are
imported as ISA Spec Sheet User Overrides.  Some fields are imported into both places.

 Exporting is done in a similar manner. For more information, see the IDM/FIRSTVUE
Interface User’s Manual.

Importing and Exporting ISA File Formats
FIRSTVUE can import and export ISA Sizing and Specification data to and from projects.
When using this feature for a project, you should also use ISA Sizing and the ISA Spec Sheet.
The data fields available for import/export include: all fields that appear on the current ISA
S20.50 Control Valve Specification Sheet, fields required by ISA Sizing, and a few other
related fields.  For a complete list of fields that can be imported/exported, check Appendix I at
the end of this manual.  It is not necessary to import or export all of the available fields - you
can pick and choose just the fields you need.

Data is imported-from and exported-to a delimited text file.  The first line of the file contains
the ordered field names of the data.  The remaining file lines contain the actual data, with
each line representing one item of the project.  Any printable character can be used as the
field delimiter.

The import will load the process conditions and sizing data into the appropriate fields within
FIRSTVUE.  This data can then be used to generate a completed sizing for the item.  Non-
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sizing data will be imported as ISA spec sheet overrides where applicable, and can be viewed
on the spec sheet dialog.  The import process only adds items to a project - it does NOT
update existing items.

Similarly, all the fields that can be imported into FIRSTVUE can be exported from FIRSTVUE.
Before exporting, be sure to review the ISA spec sheet for each item being exported.  You
can export all or some of the items in a project.

Special features of the import/export are the ability to map user defined field names to the
standard FIRSTVUE ISA names and to import/export only the fields you need in any order
that you want.  These features are accomplished by building a comma separated “mapping”
(.CSM) text file for each unique import/export format that you need.  This mapping file also
allows you to include “customer defined” fields which are imported and exported but never
used by FIRSTVUE (in effect they are place holders for fields not related to ISA data).  The
following sections detail how  to Import an ISA file, Export an ISA file, and create a Mapping
file within FIRSTVUE.

Using FIRSTVUE’s ISA Import/Export functionality, Fisher has developed interfaces with
Intergraph’s IDM and PID’s INtools instrumentation systems.  These interfaces greatly
reduce the time required to exchange process and specification data with FIRSTVUE.  They
also eliminate errors caused by the re-keying of data.  To find out more about these interfaces
and what you need to use them, contact your Fisher representative.

Importing an ISA Specification File:

1. You must have the project open that you want to import items into.  The Import
process will only create new items in your project, it will not update existing items.

2. Click on the ‘Import ISA File’ choice in the File Menu.  This will bring up an Open File
Dialog from which you can select the file you want to import.  After selecting the file,
the Import ISA File Dialog will appear with your file name displayed in the File Name
field.  To change this file name click on the ‘Browse File’ button to select a different
import file.

3. If a mapping file is needed in order to import this file, then select it by clicking on the
‘Browse Map’ button or create a new one by clicking on the ‘Create/Edit Map’ button.
After selecting/creating the mapping file, it’s name will appear in the Map File To Use
field.

4. Select the File Delimiter for the file you are importing.  You can select a character from
the dropdown list, or key-in any printable character.

5. Click on the ‘Import’ button to begin the import process.  The Import Log list box will
show the status of your import as well as any errors that might occur.  The log can be
saved to a file if needed by clicking the ‘Save Log’ button.  If errors occurred the import
file can be corrected by manually editing it with most text editors or if the lines are too
long, with a spreadsheet program such as Microsoft Excel.  Errors in field names will
cause an item to NOT be created.  Errors in field data will cause that field to not be
imported and left blank, but the item will still be created.  Errors in unit of measure for a
field will also cause an item to NOT be created.

6. Click on the ‘Close’ button to exit the Import ISA File Dialog.
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Exporting an ISA Specification File:

1.  You must have the project open that you want to export items from.

2.  Click on the ‘Export ISA File’ choice in the File Menu.  This will bring up the Export ISA
File Dialog.

3.  Click on the ‘Browse File’ button to select the file name you want to export to.  After
selecting the file, it’s name will appear in the File Name field.

4.  If the export file only needs certain fields, or needs a unique order, or needs unique field
names then you need to select or create (see Creating or Editing an ISA Mapping File) a
mapping file by clicking on the ‘Browse Map’ or ‘Create/Edit Map’ button.  After
selecting/creating the mapping file, it’s name will appear in the Map File To Use field.  If
no map file is specified, the export will contain ALL fields in the default order with standard
names.

5.  Two other radio button selections come into play if you are using a mapping file to export.
If you want to use a mapping file, but want to export the standard field names; then click
the Standard ISA Names button.  If you want to ignore the mapping file; then click the All
Fields button.  Generally you will accept the settings defaulted to, but these options allow
for complete flexibility.

6.  Select the File Delimiter that you want to use for the file you are exporting.  You can
select a character from the dropdown list, or key-in any printable character.  This is the
character that will be used to separate fields values within the export file.

7.  A list of all items on the project appears in the Select Items to Export listbox.  You can
select which items you want to export here by clicking on them individually, or click the
Select All Items check box if you want to export all the items on this project.

8.  Click on the ‘Export’ button to begin the export process. This will bring up an Open File
Dialog from which you can select the path and file name of the export file you want to
create.  After selecting the file name, a status box will appear telling you the item which is
currently being exported and at the end telling you the results of your export.  The export
file can be viewed with most text editors or if the lines are too long, with a spreadsheet
program such as Microsoft Excel.

9.  Click on the ‘Close’ button to exit the Export ISA File Dialog.

Creating or Editing an ISA Mapping File:

1. Click on the ‘Edit ISA Map File’ choice in the File Menu or click the ‘Create/Edit Map’
button from the Import or Export Dialogs.  This will bring up the Map File Edit Dialog.

5.  To open an existing map file click on the ‘Open Map File’ button to select the file.  After
selecting the file, it’s name will appear in the Map File Name field and the fields
associated with that file will appear in the Fields Selected/Custom Name spreadsheet on
the right side of the screen.  If you are creating a new map file, the Fields
Selected/Custom Name spreadsheet will be empty initially.

6.  The Fields Available list on the left side of the screen lists all the non-selected fields
available with the Fisher standard field name.  The order of these fields is roughly top to
bottom on a Standard ISA printed spec sheet.  To Add a field or fields to a map file, select
the Add/Delete button in the Select Mode box, click the fields desired to highlight them in
the Fields Available list, then click on the ‘Select >‘ button to move them over to the Fields
Selected List.  All the fields can be selected with the ‘Select All >>‘ button.  Deselecting
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works the same way, but in the opposite direction using the ‘< Deselect ‘ and ‘<< Deselect
All’ buttons.  A special “CUSTOMER-DEFINED” field is listed first in the list.  This field
allows for Non-ISA fields to be allowed for in an import or export file.  This field can be
selected as many times as needed and renamed (see 5 below) to a custom name just like
the rest of the fields.

7.  To change the field order of your map file, highlight the field in the Fields Selected/Custom
Name spreadsheet and click the ‘Move UP’ or ‘Move DOWN’ buttons to move that field up
or down in the order.  Multiple fields can be moved at once by highlighting a group of
fields.

8.  To define a custom field name for a field simply type the name in the Custom Name
column of the spreadsheet next to the standard name you want it to stand for.  To reset
ALL custom names to the default standard name click the ‘Reset Custom Names’ button.

9.  If you have a copy of the customer import file you can import it to make the building of the
map easier by entering the Delimiter of the file and clicking the Import Custom File button.
This will load the custom names in row one of the file into the Custom Name column of
the Fields Selected/Custom Name spreadsheet while leaving the Fields Selected column
blank.  The Overlay button will be selected in the Select Mode box and you can now
highlight fields in the Fields Available list and Select them to “overlay” the blank fields in
the spreadsheet.  Deselecting while in Overlay mode will blank out the highlighted field(s).

10.   Click the ‘Save’ button to save to the file listed in the Map File Name field.  Click the
‘Save As’ button to save to a new or different map file name.

11.  Click on the ‘Close’ button to exit the Map File Edit Dialog.  **Important:  Closing the
dialog does NOT automatically save your map file.  You must click the ‘Save’ or ‘Save As’
buttons to save your file.

Exporting Dimensional Data
After valve selections have been made in FIRSTVUETM and Autodraw  has assembled Type I
drawings by tag number, it is possible to export a table to dimensions into Excel by tag
number.  It can also provide a by tag basis for each dimension which can be imported into
CAD systems that can accept Excel spreadsheets.
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Chapter 6: Creating Specification Sheets and
Reports
FIRSTVUE™ lets you create three types of reports: Summary Reports, Sizing Calculation
Reports, and Specification (Spec) Sheets.

A Summary Report lists selected items in a Project and includes a brief description of each
item. A Sizing Calculation Report shows criteria you entered for a selected process condition
and the calculated results.

This chapter contains instructions for creating and printing reports and includes an example of
each type of report. It contains the following sections:

• Creating a Spec Sheet

• Printing Spec Sheets and Reports

• FIRSTVUE™ Reports Examples

 Summary Report

 Sizing Calculations Reports

 Fisher Spec Sheet

 ISA Spec Sheet

 Diffuser Spec Sheet

Creating a Spec Sheet
When you create a specification sheet, you first use the Spec Sheet Data Dialog Box to
select data and then use the Reports Dialog Box to select the specification sheet types and
other options for printing.

To display the Spec Sheet Data Dialog Box:

1. Open the appropriate Project. For instructions on opening a Project, see Chapter 4:
Creating and Opening Projects and Items.

2. Display the Sizing Screen by clicking on the Sizing Tab.

3. Click the Spec Sheet button.
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The Spec Sheet Data Dialog Box appears:

The Spec Sheet Data Dialog Box lets you customize your specification sheet.

To fill in the Spec Sheet Data Dialog Box:

1. In the Type field, select one of the following specification sheet types from the drop-down
list:

• Fisher Diffuser—Use  if you have selected a diffuser to go with your valve.

• Fisher Reg Spec—Use with regulators.

• Fisher Rot Spec—Use with rotary valves.

• Fisher SS Spec—Use with sliding stem valves.

• ISA PM—Use if you want an ISA specification sheet. (“PM” stands for Process
Measurement and Control Instruments and Valves).

NOTE: If you selected a valve body from Catalog 10 or Catalog 12, Fisher SS Spec or
Fisher Rot Spec appear automatically in the Type field. You can change this entry by
selecting from the drop-down list.

 Once you select a specification sheet type, the screen displays a spreadsheet with
appropriate display and entry fields:

• The Label column displays the labels in the different areas of the specification sheet,
such as Service, Body, etc. in gray, and field labels in white.
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• The SpecSheet Data column displays the data provided by the program.

2. Make any changes you like by selecting or typing in the User Overrides column.

3. Note any additional components or accessories on your specification sheet by entering
information and selecting from drop-down lists the Positioner, Controller, Transducer,
and Other sections.

4. When done making changes, click OK to save your entries. The Sizing Screen appears.

Printing Spec Sheets and Reports
To print specification sheets and Summary Reports, you use the Reports Dialog Box. To
display this dialog:

1. Open the appropriate Project. For instructions on opening a Project, see Chapter 4:
Creating and Opening Projects and Items.

2. From the File Menu, select Reports.

OR

 Click the Printer icon located on the Toolbar.
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The Reports Dialog Box appears:

The Reports Dialog Box lets you select the type of report and the range of items
included.This dialog displays any data previously entered in it.
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To fill in the Reports Dialog Box:

1. In the Report Types box, click one or more check boxes to select the type(s) of reports
you want to print:

• Click Project Item List to produce a Summary Report listing the items and brief item
descriptions.

• Click Fisher Spec Sheet to produce Fisher’s custom formats for sliding stem
actuators, rotary valves, and regulators.

• Click ISA Spec Sheet to produce an ISA-defined process management specification
sheet for sliding stem actuators or rotary valves.

• Click Diffuser Spec Sheet if an item includes a diffuser. You can print Diffuser
Reports only for items that include diffuser calculations in your sizing screens and
spreadsheets.

2. In the Report Types box, click check boxes to select the types of calculations you want to
include on Sizing Calculation Reports. You can select All Sizing Calculations, or any
combination of Valve Calculation, Actuator Calculation, and/or Speed Calculation.

3. In the Destination box, click the appropriate radio button:

• Click Print Preview to view the report on your screen before printing.

• Click Print to send the report directly to the printer.

4. In the Item Range box, select the range of items you want to include in the report:

• To include all items, click the All Items radio button.

• To limit the report to a range of items:

a. Click the Items radio button.

b. Enter the range of items in the From and To fields by selecting from the drop-
down lists.

5. In the Options box, click in the appropriate check boxes if you want to omit warnings
and/or material code descriptions.
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6. To print or preview the report, click the OK button.

NOTE: You can reduce your printing time by up to 80% by printing in draft mode. To do this,
click the Draft check box before printing. For most printers, the only difference between draft
mode and normal printing is that in draft mode the vertical lines in FIRSTVUE™ reports are
thicker than the vertical lines printed in normal mode.

7. If you select Print, the Windows print dialog appears. Select the number of copies and
other options you wish and click Ok. The reports print and the Sizing Screen appears.

If you select Print Preview, the Print Preview Dialog Box appears:

The Print Preview Dialog Box lets you view the report on your screen before printing. To use
this dialog, click the appropriate  buttons at the top of the dialog:

• Print—Displays the Windows print options dialog and lets you print the report.

• Next Page—Displays the next page of the report on your screen.

• Prev Page—Displays the previous page of the report on your screen.

• Two Page—Displays two pages at a time on your screen.

• Zoom In—Increases the report size on your screen. You can view the report at 75%,
110% and 200% of a full page size.

• Zoom Out—Reduces the report size on your screen.
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NOTE: You can use the vertical scroll bar on the right of the screen to move within a page
and from page to page. When the screen displays a full page, scrolling takes you to the next
or previous pages. When the screen displays part of a page in expanded views, scrolling
moves you within the page.

FIRSTVUE™ Reports Examples
FIRSTVUE™ lets you create the following types of reports:

• Summary Report—Lists each item in a Project and a brief description of each item.

• Sizing Calculation Report—Contains the sizing data you entered and calculated results
for a selected condition.

• Fisher Spec Sheet—Uses Fisher’s custom formats to display  sliding stem actuator,
rotary valve, and regulator specifications.

• ISA Spec Sheet—Uses ISA-defined process management format to display sliding stem
actuator or rotary valve specifications.

• Diffuser Spec Sheet—Displays diffuser data.

The following pages contain examples of each type of report.
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Summary Report

A Summary Report lists the items in a Project and includes a brief description of each item.
Here is an example of a Summary Report:
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Sizing Calculation Report

A Sizing Calculation Report contains sizing data you entered and calculated results for a
selected condition. Here is an example of a Sizing Calculation Report:
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Fisher Spec Sheet

A Fisher Spec Sheet uses Fisher’s custom formats for displaying sliding stem actuator, rotary
valve, and regulator specifications. Here is an example of a Fisher Spec Sheet:
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ISA Spec Sheet

An ISA Spec Sheet uses the ISA-defined process management format for displaying sliding
stem actuator or rotary valve specifications. Here is an example of an ISA Spec Sheet:



Chapter 6: Creating Specification Sheets and Reports

68 

Diffuser Spec Sheet

A Diffuser Spec Sheet displays diffuser data. Here is an example of a Diffuser Spec Sheet:
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Chapter 7: Additional Help Resources
This chapter provides an overview of the Help system and its contents. Additional instructions
for using Help are contained in the On-line Help system itself.

This chapter contains the following sections:

• Getting Help for the Active Screen or Field

• Getting Help for a Selected Topic

• Using Hypertext Links

• Accessing On-line Data Tables

• Accessing the On-line Glossary

Getting Help for the Active Screen or Field
FIRSTVUE™’s context-sensitive Help provides information about the active field or screen.
To display context-sensitive Help:

1. Click the Help Icon  in the Tool Bar at the top of your screen.

 The cursor turns into a question mark, indicating Help is active.

2. Click on a field to display information about it, or click on the screen background to display
information about the whole screen.

3. When done, to turn off context-sensitive Help, click the Help Icon.

Getting Help for a Selected Topic
FIRSTVUE™ Help files contain instructions for using the program.

To get help for a selected topic:

1. Display the Help files as follows:

• Click the Help Files Icon  in the Tool Bar at the top of the screen.

— OR —

• Press: [F1].

— OR —

• Select the Contents, Search or Using Help command from the Help Menu.
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The Help Dialog Box appears:

2.  Click the Search button.

3.  The Help Search Index Box appears:
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3. Select a topic from the Help Search Index Box:

a. Type a word or select one from the list.

b. Click the Show Topics button.
The available topics appear in the lower text area.

c. Click on a topic to select it, and then click the Display button.

 Help on the selected topic appears.

4.  To locate where specific words appear within On-line Help, select the Find tab. By typing
the words, specific locations where those words appear will be identified in the lower box.
Selecting Display will move Help to the identified topic.

5. You can navigate within Help and print and copy topics by using the following buttons and
commands:

• To print the topic, click the Print button.

• To copy the topic to your clipboard, click the Copy button.

•  To view the previous Help screen, click the Back button.

• To display the preceding topic, click the << button.

• To display the next topic, click the >> button.

• To display a list of topics you viewed recently, click the History button.

• To get help on using Help, select How to Use Help from the Help Menu.

5. When done, to close Help, click the Exit Help button.
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Using Hypertext Links
Hypertext links let you jump to related topics quickly. Hypertext links appear as green,
underlined words or phrases within the on-line Help text. To jump to the topic, double-click the
underlined word or phrase.

Accessing On-line Data Tables
On-line Help contains comprehensive data tables of engineering values, calculations, and
measurements. To access these tables, click “Data Tables” in the Table of Contents within
Help.
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Accessing Express Help
FIRSTVUE™ Help contains a quick access capability for commonly referenced items. By
selecting “Express” in the Help Table of Contents, the following box will appear:
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Appendix I
FIELDS available for FIRSTVUE Import/Export

NOTES

- FIRSTVUE imports/exports delimited text files.

- The delimeter can be any printable character.  For Excel applications, we suggest using the COMMA (.csv).

      For applications where you have more delimiter choices, we suggest the VERTICAL BAR "|".

- The fields available for Import/Export are based on the ISA S20.50 Control Valve Spec Sheet.

- You can import/export All or Some of the available fields.

- The first row of the import/export file must contain the Field Names of the fields being imported/exported.

- The remaining rows in the import/export file consist of 1 row per Item.

- Up to 15 Sizing Notes can be imported/exported for each item - these notes do NOT print on the spec sheet.

- "CUSTOMER-DEFINED" fields are fields that are imported and eventually exported unchanged.

      They cannot be seen or modified in FIRSTVUE.  There is no limit to the number of these fields that can be used per item.

LEGEND:

FIRSTVUE Field Name: (*= Appears on list of available fields in FIRSTVUE, but is not used anywhere. Not recommended for
use at this time.)

ISA Line#: ISA S20.50 Spec Sheet Line Number ("N/A" = Not Applicable - i.e. field is not on ISA Spec Sheet)

Length: FIRSTVUE Maximum Length (BLANK = No set limit as long value is within an acceptable range.  Most sizing fields = 3
decimal places.)

Valid Values: Valid Values for FluidState and Unit-of-Measure (UOM) Fields, separated by a comma.

FIRSTVUE Field Name ISA Line# Length Valid Values, Separated by a Comma “,”
ItemTag Header 20
ProjectName Header 33
ProjectUnit Header 10
PONum Header 34
QuoteItemNum Header 6
POItemNum Header 6
POItemRev Header 4
ContractNum Header 25
MFRSerial Header 25
DataSheetNum Header 5
DataSheetOf Header 5
QuoteId Header 10
QuoteRevId Header 3
DWGNum Header 25
ServiceDesc Header 30
FluidName 1 24
FluidState N/A Liquid, Gas, Vapor
CriticalPress 1
CriticalPressUOM 1 psig, psia, in. wc g, bar(a), bar(g), kg/cm2g, kg/cm2a, kPa(a), kPa(g)
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OtherConditionName 1
FlowRateUOM 2 lb/h, kg/h, gpm(US), l/m, m3/h, barrel/d, scfh, Mmscfd, scfm, Nm3/h,

scfdFlowRateMax 2
FlowRateNorm 2
FlowRateMin 2
FlowRateOther 2
InPressUOM 3 psig, psia, in. wc g, bar(a), bar(g), kg/cm2g, kg/cm2a, kPa(a), kPa(g)
InPressMax 3
InPressNorm 3
InPressMin 3
InPressOther 3
OutPressUOM 4 psig, psia, in. wc g, bar(a), bar(g), kg/cm2g, kg/cm2a, kPa(a), kPa(g)
OutPressMax 4
OutPressNorm 4
OutPressMin 4
OutPressOther 4
InTempUOM 5 deg F, deg C, deg R, deg K
InTempMax 5
InTempNorm 5
InTempMin 5
InTempOther 5
DensityUOM 6 lb/ft3, kg/m3
DensityMax 6
DensityNorm 6
DensityMin 6
DensityOther 6
SpecificGravityMax 6
SpecificGravityNorm 6
SpecificGravityMin 6
SpecificGravityOther 6
MolWeightMax 6
MolWeightNorm 6
MolWeightMin 6
MolWeightOther 6
ViscosityUOM 7 cSt, cP, SSU, mPa.s
ViscosityMax 7
ViscosityNorm 7
ViscosityMin 7
ViscosityOther 7
SpecHeatRatioMax 7
SpecHeatRatioNorm 7
SpecHeatRatioMin 7
SpecHeatRatioOther 7
SpecVaporPressUOM 8 psig, psia, in. wc g, bar(a), bar(g), kg/cm2g, kg/cm2a, kPa(a), kPa(g)
SpecVaporPressMax 8
SpecVaporPressNorm 8
SpecVaporPressMin 8
SpecVaporPressOther 8
ReqCvMax 9
ReqCvNorm 9
ReqCvMin 9
ReqCvOther 9
TravelMax 10 9
TravelNorm 10 9
TravelMin 10 9
TravelOther 10 9
AllowSPLMax 11 5
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AllowSPLNorm 11 5
AllowSPLMin 11 5
AllowSPLOther 11 5
PredictSPLMax 11
PredictSPLMaxLTSignOnly 11 1 <
PredictSPLMaxValueOnly 11
PredictSPLNorm 11
PredictSPLNormLTSignOnly 11 1 <
PredictSPLNormValueOnly 11
PredictSPLMin 11
PredictSPLMinLTSignOnly 11 1 <
PredictSPLMinValueOnly 11
PredictSPLOther 11
PredictSPLOtherLTSignOnly 11 1 <
PredictSPLOtherValueOnly 11
Line12ConditionName 12 25
Line12UOM 12 9
Line12Max 12 9
Line12Norm 12 9
Line12Min 12 9
Line12Other 12 9
InPipeLineSched 13 25
InPipeLineSize 13 25
PipeLineUOM 13,14 in, mm
OutPipeLineSched 14 25
OutPipeLineSize 14 25
OutPipeLineOD 14
OutPipeLineWallThick 14
PipeInletDiameter N/A
PipeOutletDiameter N/A
ValveInletOutletDiameter N/A
PipeLineInsType 15 14
PipeLineInsThick 15 5
PipeLineInsThickUOM 15 5
ValveBodyType 16 17
ValveBodySize 17 12
ValveBodySizeUOM 17 12 in, mm
ValveBodyANSIClass 17 17
MaxPress 18 8
MaxPressUOM 18 8
MaxTemp 18 6
MaxTempUOM 18 5
ValveMFR 19 10
ValveModel 19 20
BodyMatl 20 25
BonnetMatl 20 25
BodyLinerMatl 21 20
BodyLinerID 21 4
BodyLinerIDUOM 21 2
InEndConn 22 20
InEndConnSize 22 4
InEndConnSizeUOM 22 2
InEndConnRating 22 6
OutEndConn 23 20
OutEndConnSize 23 4
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OutEndConnSizeUOM 23 2
OutEndConnRating 23 6
FlgFaceFinish 24 25
EndExtLength 25 4
EndExtLengthUOM 25 2
EndExtMatl 25 20
FlowDirection 26 25
BonnetType 27 25
LubIsoValve 28 10
Lube 28 10
PackingMatl 29 23
PackingType 30 25
ExtraBodyBonnetAttr 31 40
TrimType 32 25
TrimSize 33 18
TrimSizeUOM 33 18
TrimRatedTravel 33 16
TrimRatedTravelUOM 33 16 in, mm
TrimCharacter 34 25
TrimBalance 35 40
TrimRatedCv 36 11
TrimRatedCvValueOnly 36 9
TrimRatedCvUnitOnly 36 2 Cv, Cg, Cs
TrimRatedFl 36 8
TrimRatedXt 36 8
ClosureMatl 37 25
SeatMatl 38 25
CageGuideMatl 39 25
StemMatl 40 25
ExtraTrimAttr 41 40
ExtraTrimAttr2 42 40
NECClass 43 15
NECDiv 43 7
NECGroup 43 9
SpecAccReq1 44 40
SpecAccReq2 45 40
SpecAccReq3 46 40
SpecAccReq4 47 40
SpecAccReq5 48 40
SpecAccReq6 49 40
SpecAccReq7 50 40
SpecAccReq8 51 40
SpecAccReq9 52 40
ActuatorType 53 24
ActuatorMFR 54 10
ActuatorModel 54 25
ActuatorSize 55 17
ActuatorSizeUOM 55 17
DiaphragmArea 55 6
DiaphragmAreaUOM 55 3 in2, mm2, cm2
ActuatorServiceInd 56 7
ActuatorModulating 56 13
SpringActionInd 57 25
ActuatorMaxAllowPress 58 8
ActuatorPressUOM 58.59 8 psig, psia, in. wc g, bar(a), bar(g), kg/cm2g, kg/cm2a, kPa(a), kPa(g)
ActuatorMinReqPress 59 8
MaxAvailAirSupplyPress 61 8
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AvailAirSupplyPressUOM 61 8 psig, psia, in. wc g, bar(a), bar(g), kg/cm2g, kg/cm2a, kPa(a), kPa(g)
MinAvailAirSupplyPress 61 8
MinBenchRange 62 25
MaxBenchRange 62 25
BenchRangeUOM 62 25 psig, psia, in. wc g, bar(a), bar(g), kg/cm2g, kg/cm2a, kPa(a), kPa(g)
ActuatorOrient 63 24
HandWheelType 64 24
AirFailValveInd 65 7
AirFailValvePress 65 10
AirFailValvePressUOM 65 8
ExtraActuatorAttr 66 40
InputSignalMin 67 23
InputSignalMax 67 23
InputSignalUOM 67 23
PositionerType 68 24
PositionerMFR 69 10
PositionerModel 69 26
SignalOutIncrDecr 70 22
AirPressGaugeInd 71 26
PositionerBypassInd 71 4
CamCharacter 72 22
ExtraPositionerAttr 73 40
SwitchType 74 25
SwitchQty 74 6
SwitchMFR 75 10
SwitchModel 75 25
ContactForm 76 4
SwitchCurrentRating 76 4
SwitchCurrentRatingUOM 76 2
SwitchVoltageRating 76 3
SwitchVoltageRatingUOM 76 2
SwitchFrequency 76 3
SwitchFrequencyUOM 76 2
ActuationPoints 77 24
ExtraSwitchAttr 78 40
AirSetMFR 79 10
AirSetModel 79 25
AirSetPress 80 8
AirSetPressUOM 80 8
AirSetFilterInd 81 10
AirSetGaugeInd 81 18
ExtraAirSetAttr 82 40
HydroPressTest 83 8
HydroPressTestUOM 83 8
LeakageClass 84 23
ExtraTestReq1 85 40
ExtraTestReq2 85 40
ISASpecRev Revision 3
ISASpecRevDate Revision 11
ISASpecRevDesc Revision 20
ISASpecRevOrig Revision 6
ISASpecRevAppv Revision 6
ISASpecRev2 Revision 3
ISASpecRevDate2 Revision 11
ISASpecRevDesc2 Revision 18
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ISASpecRevOrig2 Revision 6
ISASpecRevAppv2 Revision 6
ISASpecRev3 Revision 3
ISASpecRevDate3 Revision 11
ISASpecRevDesc3 Revision 18
ISASpecRevOrig3 Revision 6
ISASpecRevAppv3 Revision 6
ISASpecRev4 Revision 3
ISASpecRevDate4 Revision 11
ISASpecRevDesc4 Revision 18
ISASpecRevOrig4 Revision 6
ISASpecRevAppv4 Revision 6
ISASpecRev5 Revision 3
ISASpecRevDate5 Revision 11
ISASpecRevDesc5 Revision 18
ISASpecRevOrig5 Revision 6
ISASpecRevAppv5 Revision 6
CriticalTemperature N/A
CriticalTemperatureUOM N/A deg F, deg C, deg R, deg K
CompressibilityFactor N/A
ValveStyleModifierFd N/A
LineNumber N/A 30
LineType N/A 20
FLMax N/A
FLNorm N/A
FLMin N/A
FLOther N/A
XTMax N/A
XTNorm N/A
XTMin N/A
XTOther N/A
CompressibilityFactorMax N/A
CompressibilityFactorNorm N/A
CompressibilityFactorMin N/A
CompressibilityFactorOther N/A
PressureDropMax N/A
PressureDropNorm N/A
PressureDropMin N/A
PressureDropOther N/A
PressureDropUOM N/A
InstrumentTypeName N/A 6
PlantName N/A 30
AreaName N/A 30
UnitNumber N/A 6
LoopName N/A 20
MeasuredVariable N/A 6
SpecFormNumber N/A 20
EnclosureTag N/A 20
SolenoidTag N/A 20
ActuatorTag N/A 20
AirFailValveTag N/A 20
PositionerTag N/A 20
SwitchTag N/A 20
AirsetTag N/A 20
RepName N/A 35
SIZING-NOTE N/A Can have up to 15 Sizing Notes per Tag
CUSTOMER-DEFINED N/A Cannot be seen or modified in FIRSTVUE. Unlimited number can be

used.
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ItemOwner* N/A
SpecSheetType* N/A
ResponseOrg* N/A
RefSpec* N/A
CustomerName* N/A
JobNum* N/A
PlantSite* N/A
InPressShutoff* N/A
OutPressShutoff* N/A
InTempShutoff* N/A
InPipeLineOD* N/A
InPipeLineWallThick* N/A
EndExtSched* N/A
IPXcderInd* N/A
SolenoidValveInd* N/A
EstWeight* N/A
EstWeightUOM* N/A
FaceToFaceDim* N/A
FaceToFaceDimUOM* N/A
OverallHgt* N/A
OverallHgtUOM* N/A
RemoveClearance* N/A
RemoveClearanceUOM* N/A


